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Trademarks 
Unigraf, UCD, UCD-300, UCD Console and TSI are trademarks of Unigraf Oy. 

DisplayPortµ and the DisplayPortµ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

The Adopted Trademarks HDMI, High-Definition Multimedia Interface, the HDMI Logo, and HDMI 

Port Logo are trademarks or registered trademarks of HDMI Licensing Administrator, Inc. in the 

United States and other countries. 

HDCP is a trademark of Digital Content Protection LLC. 

Altera and Intel FPGA are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or 

other countries. 

Windows® 11, Windows® 10 and Windows® 8 are trademarks of Microsoft Corporation. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, 

under normal use and service, for twelve (12) months from the date of purchase from Unigraf or 

its authorized dealer. 

If the product  proves defective within the warranty period, Unigraf will provide repair or 

replacement of the product. Unigraf shall have the whole discretion whether to repair or replace, 

and replacement product may be new or reconditioned. Replacement product shall be of 

equivalent or better specifications, relative to the defective product, but need not to be identical. 

Any product  or part repaired by Unigraf pursuant to this warranty shall have a warranty period of 

not less than 90 days, from the date of such repair, irrespective of any earlier expiration of original 

warranty period. When Unigraf provides replacement, then the defective product becomes the 

property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf will 

provide instructions for returning the defective product. 

CE Mark 
UCD-300 family products meet the essential health and safety requirements, is in conformity with 

and the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is User Manual of UCD-301, UCD-323 and UCD-340, USB-connected video interface 

test units for use with a PC with Windows® 11,  Windows® 10 or Windows® 8 operating system. 

The purpose of this guide is to 

¶ Provide an overview of the products and their features. 

¶ Provide instructions for the user on how to install the software and the drivers. 

¶ Provide instructions for the user on how to update the FW of the unit. 

¶ Introduce the HW features of the units. 

¶ Provide instructions for the user on how to use UCD Console software. 

 

Product and Software Version 
This manual explains features found in UCD Console Software Bundle 2.4. Please consult Unigraf 

for differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW and 

FW versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text is 

formatted as follows. Please read these notes carefully. 

Note: This text is an important note 

 

 

Note: This version of the User Manual describes features in UCD Console software version 2 based on 

the functionality in Microsoft Windows operating system. 

 

UCD Console is available also for macOS operating system to be used in iMac and MacBook 

computers and for Linux operating system.  

 

Detailed description of the macOS and Linux versions will be added later. 
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 INTRODUCTION 

Product Description 
UCD-300 family are high speed, USB 3.0 connected video interface test unit. UCD-300 series 

consists of the following units: 

UCD-301 DisplayPort 1.4 and HDMI 2.0 analyzer 

UCD-323 DisplayPort 1.4 and HDMI 2.0 analyzer and generator 

UCD-340 USB-C DisplayPort Alt Mode analyzer and generator 

USB-C External 

Power Test Unit 

Accessory to UCD-340 for testing Power load for USB-C Sink or Source 

DUT. 

UCD Console is user interface (GUI) for UCD family test equipment for desktop use. The outlook 

and details of UCD Console will vary depending on the capabilities of the connected unit  and will 

reflect the features enabled.  

Unigraf UCD units feature a high-level Software Development Kit (SDK) called Test Software 

Interface (TSI) for use in automated testing. TSI allows for an easy integration of Production and 

R&D testing routines into an automated test system environment. Please refer to TSI 

documentation found in additional Unigraf manuals for more details. 

UCD-301 Digital 

Product Features  

¶ Support for HDMI 2.0 and DP 1.4 display interface 

¶ High resolution video and audio capture up to up to 4K / UHD 60 Hz 

¶ Compatible with HDCP versions 1.3 / 1.4 and 2.2 / 2.3 

¶ 2 GB on-board high-speed video buffer 

¶ High speed USB 3.0 host PC interface 

Functional Description  

UCD-301 units consist of a multimedia signal input stage, a control stage with on-board frame 

buffer and a PC interface stage. In the Input Stage the signal is conditioned and converted to 

desired format. The Interface and Control stages are either passing the captured data directly to 

the USB interface or storing it to the frame buffer. Interface & Control stages are receiving 

instructions from the host PC to configure and control the funct ionality of the unit. 

Please find below logical diagram of UCD-301 unit 

UCD-301 

Control & 

Interface 
USB 3.0 

Host PC 

DP Input DP 

HDMI Input HDMI 

Electrical 

Testing 

On-board 

Frame Grabber 
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Delivery Content  

UCD-301 product shipment contains: 

¶ The UCD-301unit 

¶ AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

¶ USB 3.0 compliant cable  

 Connections  

The image below indicates the connections in UCD-301 unit and their description 

Name Description 

DP In DisplayPort 1.4 compliant input from the upstream Source 

HDMI In HDMI 2.0 compliant input from the upstream Source 

S/PDIF In Test input for ARC Function  

Power In +12 Vdc Power Supply Input 

USB USB 3.0 connection to the host PC 
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UCD-323 HDDP and UCD-323 Gen2 

Product  Features  

¶ High resolution video and audio capture up to up to 4K / UHD 60 Hz 

¶ Support for multiple display interfaces including HDMI 2.0 and DP 1.4  

¶ Compatible with HDCP versions 1.3 / 1.4 and 2.2 / 2.3 

¶ UCD-323 HDDP 2 GB (optionally 4 GB), UCD-323 Gen2 4 GB on-board video buffer 

¶ High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description  

UCD-323 units consist of a multimedia signal input stage, an internal pattern generator, a control 

stage with on-board frame buffer and a PC interface stage. In the Input Stage the signal is 

conditioned and converted to desired format.  

The Interface and Control stages are either passing the captured data directly to the USB interface 

or storing it to the frame buffer.  

The internal pattern generator is able to source a signal for testing sink and branch units. The 

Interface & Control stages are receiving instructions from the host PC to configure and control 

the functionality of the unit. 

AUX Controller for PHY CTS 

UCD-323 Gen2 is a companion tool for PHY test equipment to perform automated DP 2.0 PHY 

compliance testing for Source and Sink DUT. AUX controller is supported using Unigraf TSI API. 

Please find below logical diagram of UCD-323 unit 

Delivery Content  

UCD-323 product shipment contains: 

¶ The UCD-323 unit 

¶ AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

¶ USB 3.0 compliant cable  

  

UCD-323 

Control & Interface 
USB 3.0 

Host PC 
DP In / Out DP 

HDMI In / Out HDMI 

Internal 

Pattern Generator 

On-board 

Frame Grabber 
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Connections  

The image below indicates the connections in UCD-323 unit and their description 

Name Description 

DP in DisplayPortµ 1.4 compliant input from the upstream Source 

DP out DisplayPortµ 1.4 compliant output to the downstream Sink 

HDMI in HDMI 2.0 compliant input from the upstream Source 

HDMI out HDMI 2.0 compliant output to the downstream Sink 

Power in +12 Vdc Power Supply Input 

USB USB 3.0 connection to the host PC 
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UCD-340 

UCD-340 Product Features  

¶ Test unit for testing power delivery and DP Alt Mode functions of USB-C interface 

¶ Monitoring and control of data and power delivery roles of the USB-C interface 

¶ Optional Power Test Unit for testing high voltage and power options 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description  

UCD-340 is an integrated test unit for verifying the performance of PD and DP Alt Mode functions 

in a USB Type-C device.  

UCD-340 unit consist of a USB-C signal input stage with data multiplexer with either two 

directional data pass-through to USB2 or USB3 interfaces or connection to DP Alt Mode input / 

output block.  

The USB-C input stage consists of capability for electrically testing the continuity of input signals. 

An optional separate Power Test unit is sourcing or sinking the various voltages for testing USB-

C power options. 

The DP Alt Mode block includes frame grabber and pattern generator funct ions for emulating DP 

Alt Mode source and sink functions. 

 

Delivery Content  

UCD-340 product shipment contains: 

¶ The UCD-340 unit 

¶ AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

¶ USB 3.0 compliant cable 

¶ USB-C to USB-C test cable 

¶ Unigraf Electrical test cable (with units including Electrical Test) 

 

UCD-340 

Control & 

Interface 
USB 3.0 

Host PC 

Data 

Multiplexer 
USB-C 

USB-2 

USB-3 

Data Pass-through 

Power 

Test 

Unit 

Electrical 

Testing 

Power 

Delivery 

DP Alt Mode 

 Internal 

Pattern Generator 

On-board 

Frame Grabber 
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UCD-340 Connections  

The image below indicates the connections in UCD-340 unit and their description 

 

Name Description 

USB-C USB Type-C Connection to the evaluated device (DUT) 

USB 3 Device USB Type-A connector for an auxiliary USB 3.1 ¯Device° for data 

pass-through 

USB 3 Host USB Type-B connector for an auxiliary USB 3.1 ¯Host° for  

data pass-through 

External  

Power Test Unit 

Connector for Unigraf®s ¯USB-C External Power Test Unit°  

Power in +12 Vdc Power Supply Input 

USB 3 to host PC USB 3.0 connection to the controlling PC 

 

Note: Capturing and sourcing high resolution video modes, especially 4K video modes set stringent 

requirements on the video cables and connectors. Please contact Unigraf for assistance and 

details about evaluated cables. 

 

Warning  In order to avoid possible damage to the UCD unit and the PC, please always attach the power 

cord (Power In) to UCD-300 unit first , and after that connect the USB cable to your PC. 
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Unigraf Electrical Test Cable  to UCD-340 

Some features of the Electrical Test function in UCD-340 are available only when using the special 

Electrical Test Cable provided by Unigraf. Electrical Test Cable includes extra wires enabling 

UCD-340 to individually measure the electrical continuity of DUT®s four VBUS and four GND 

signals that are normally tied together at DUT®s end of the cable. Please refer to the image below 

for clarification. 

Note: When attaching Unigraf Electric Test Cable, please make sure that the finger-screw is tightened 

all-the-way into its hole. When tightened, the finger-screw triggers a switch indicating the 

presence of Unigraf Electric Test Cable. 

You can also verify that Unigraf Test Cable is plugged from UCD Console by selecting vertical 

Tab USB-C, horizontal tab Roles and Modes . The indicator text can be found in the bottom bar. 

Two Electrical Test Cable Types 

Please note that there are two versions for Unigraf Electrical Test Cable. The difference is the 

number of USB D+/- pairs included in the cable. 

¶ If DUT has shorted USB2.0 pins A6 to B6 and A7 to B7 at the receptacle then choose cable 

One: In order to minimize in-cable signal coupling only one USB D+/- pair is included in the 

cable. 

¶ If DUT has shorted USB2.0 pins routed to mux or similar, then choose cable Two: In order 

to enable electrical cable flip in cases where USB D+ lines and USB D- lines correspondingly 

have not been shorted together on Device side, both USB D+/- pairs are included in the 

cable. This cable marked with a label ¯2xUSB 2.0 PAIRS°. 
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USB-C External Power Test Unit 
Unigraf External USB-C Power Test Unit connected to UCD-340 enables testing extended USB 

power options. Please find below a matrix describing Power Source and Power Sink options of 

UCD-340 internally and with attached Unigraf External Power Test Unit. Please find description of 

controlling the power options with UCD Console later in this manual. 

Power Test Capability  

The table below indicates which Vbus voltages and current ranges are available with UCD-340 

only and which with UCD-340 combined with USB-C External Power Test Unit 

 5 V 9 V 12 V 15 V 20 V 

Used equipment: 0.5 A 0.9 A 1.5 A 3 A 3 A 3 A 3 A 5 A 

Vbus Source capability         

UCD-340 ǒ ǒ ǒ ǒ     

UCD-340 with 

USB-C External Power Test Unit 
ǒ ǒ ǒ ǒ ǒ ǒ ǒ ǒ 

Vbus Sink capability         

UCD-340 ǒ ǒ ǒ ǒ     

UCD-340 with  

USB-C External Power Test Unit 
ǒ ǒ ǒ ǒ ǒ ǒ ǒ ǒ 
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Safety and Operational Precautions 
Please find below the Safety Precautions  for using the Unigraf UCD test instrument. Please also 

carefully read the Notes and Warnings  within the text of this manual.  

These Precautions and Warnings  are provided to enable a safe use of the UCD test equipment. 

Therefore, Unigraf assumes no liability when the user fails to follow the expressed Precautions 

and Warnings.  

¶ Use only Unigraf provided AC/DC Power Adapter. Please make sure that connectors and 

cabling to the Power Adapter are intact. In case there are any doubts about the condition of 

the Adapter or cabling, stop using it immediately. 

¶ It is important to ensure that the used AC input voltage is within the specified range (100 to 

240 Vac 50/60 Hz) and the fuses in the AC lines are of the specified type. If in doubt, do not 

connect the device. 

¶ When installing the unit, connect the Power Adapter to the UCD device first, after that 

connect the AC plug. Please disconnect the USB cable to the controlling PC and remove 

cabling to DUT while connecting the power input cables. 

¶ It is forbidden to open the housing of the UCD device without a written permission from 

Unigraf. Failure to comply with this rule will void the warranty of the unit. 

¶ UCD devices are intended for use as Electrical Test Instrument only. Use for other purposes 

is forbidden. 

¶ Use UCD equipment only in its specified ambient temperature and humidity.  

¶ In order to ensure that the UCD device and associated SW will operate properly, please 

ensure that the PC used for controlling the UCD device complies with the minimum 

requirement set by Unigraf. 

¶ Please keep UCD software updated by regularly checking the updates on Unigraf download 

page (https://www.unigraf.fi/downloads/). Please update the device firmware to match the 

installed software. 
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 INSTALLATION 

Installation Package 
The UCD software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/  

The installation package is a bundle between the components needed for UCD Console and for 

TSI SDK. The bundle contains the following items: 

¶ Windows drivers (installed during set up)  

¶ UCD Console software (installed during set up) 

¶ License Manager (installed during set up) 

¶ Device configuration utility (installed during set up) 

¶ Packet Editor (installed during set up) 

¶ Pattern Editor (installed during set up) 

¶ TSI SDK (installed during set up) 

¶ User Manuals including this document. 

Note: The software should be installed before connecting the UCD unit to the PC. 

 

Note: System administrator's privileges are required for performing the installation. 

Software Installation 
u Start the installation by running application SoftwareBundle_ X.X.XXXX (X.X.XXXX denotes 

the installed software version) 

Once the installer has started, a welcome page is displayed. The welcome page shows the 

software package release version. 

The user is also asked to confirm 

¶ Creating a desktop shortcut 

¶ Installation of Visual C++ redistributable 

¶ Installation of Unigraf USB drivers 

u Next dialog confirms the selections made. If you are ready, click Install to start the 

installation. 

u Click Finish  to exit the installation dialog. 

Firmware Installation 
Along with the change to UCD Console software version 2, Unigraf is restructuring the software 

(SW) builds and releases. For the time being we are releasing firmware (FW) packages separately 

from SW for UCD product families. This means that SW installation does not  automatically install 

the new FW package. 

After software installation is completed, please download the FirmwarePackage_X.X.XXXX  

(X.X.XXXX denotes the installed firmware version) also available on Unigraf download page 

https://www.unigraf.fi/downloads/ and run the included application. 

New firmware files will automatically be copied to the correct location in the PC. Please follow 

instructions in Firmware Update Procedure below to update firmware in the UCD device. 

  

https://www.unigraf.fi/downloads/
https://www.unigraf.fi/downloads/
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Firmware Update Procedure 
UCD Configuration Utility is used to load an updated firmware to the device. As an option, UCD 

Configuration Utility can be used to select possible alternative operation roles for the UCD unit. A 

firmware set for the selected operation roles is created and the firmware set is programmed to 

the device. Please contact Unigraf for details. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC and do 

not power it off before the operation is completed unless specially requested. Avoid plugging and 

unplugging other USB devices when the firmware update is in progress. 

To update the firmware or create a new configuration on a UCD device, please perform the 

following steps: 

u Connect the UCD unit to a power supply and connect the USB cable. 

u Open UCD Console. Select Tools > Firmware Update. 

The first page of the utility indicates the firmware component versions present in the package. 

Please click Next . 

From the list of connected UCD devices please select the one that you want to update. Click Next .  

Updated Modules  

The tool lists the FW components available in the UCD device, the currently programmed FW 

version, and the FW installed in the PC for programming. 

u Click Start to start programming.  

 Power Cycle  

When re-initiating the firmware of a UCD device the whole process cannot be done during one 

session. Therefore, on certain point, user needs to power cycle the device (switch off power from 

UCD device > wait for 10 seconds > re-apply power to UCD device). 

Click OK button on the dialog. 

Note:  The procedure may take several minutes depending on the speed of the USB connection of the 

host PC. 

FW currently 

programmed in UCD 

FW available for 

programming FW component 
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Select Role 
The use of UCD-300 devices with UCD Console is divided in display interface specific roles. The 

structure of UCD Console varies between roles by having a varying set of tabs dedicated to 

functionalities available in the enabled role. The table below lists the roles and tabs available in 

each role. Please find a detailed description of each role in the later chapters of this manual. 

Please find a description on changing device configuration later in this document. 

Each UCD-300 model features a unique set of modes available. In special occasions, Unigraf can 

create custom configurations. Please contact Unigraf Support for details.  

Available Mode Configurations for UCD -301 

In addition to the separate HDCP 2.3 enabled HDMI and DP Reference Sink roles, in UCD-301 

you can select a combined mode where three roles are available in one configuration. 

 

Role Tabs available 

HDMI Reference Sink (HDCP 2.3) 

Video preview and saving (Video). 

Audio monitoring and saving (Audio).  

Status information and control of the upstream link (Link). 

EDID editor (EDID). 

HDCP 1.4 and 2.3 status monitor and control (HDCP). 

Monitor InfoFrame data (InfoFrames). 

Executing TSI Test cases (Source DUT Testing). 

DisplayPort Reference Sink (HDCP 2.3) 

Video preview and saving (Video). 

Audio monitoring and saving (Audio). 

Status information and control of the upstream link (Link). 

EDID editor (EDID). 

DPCD editor (DPCD). 

HDCP 1.3 and 2.3 status monitor and control (HDCP). 

Monitor Secondary-Data Packets (SDP) 

Event log (Event log) 

Executing TSI Test cases (Source DUT Testing). 

Executing HDCP 2.3 CTS Tests (Source DUT Testing). 

Combined Mode 

 

HDMI Reference Sink 

Video preview and saving (Video). 

Audio monitoring and saving (Audio).  

Status information and control of the upstream link (Link). 

EDID editor (EDID). 

HDCP 1.4 status monitor and control (HDCP). 

Read InfoFrame data (InfoFrames). 

Executing TSI Test cases (Source DUT Testing). 

DisplayPort Reference Sink 

Video preview and saving (Video). 

Audio monitoring and saving (Audio). 

Status information and control of the upstream link (Link). 

EDID editor (EDID). 

DPCD editor (DPCD). 

HDCP 1.3 status monitor and control (HDCP). 

Executing TSI Test cases (Source DUT Testing). 
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Available Mode Configurations for UCD -323 

Role Tabs available 

HDMI Reference Sink  

(HDCP 2.3) 

Video preview and saving (Video). 

Audio monitoring and saving (Audio).  

Status information and control of the upstream link (Link). 

EDID editor (EDID). 

HDCP 1.4 and 2.3 status monitor and control (HDCP). 

Monitor InfoFrame data (InfoFrames). 

Executing TSI Test cases (Source DUT Testing). 

DisplayPort Reference Sink 

(HDCP 2.3) 

Video preview and saving (Video). 

Audio monitoring and saving (Audio). 

Status information and control of the upstream link (Link). 

EDID editor (EDID). 

DPCD editor (DPCD). 

HDCP 1.3 and 2.3 status monitor and control (HDCP). 

Monitor Secondary-Data Packets (SDP) 

Event log (Event log) 

Executing TSI Test cases (Source DUT Testing). 

Executing HDCP 2.3 CTS Tests (Source DUT Testing). 

HDMI Reference Source  

(HDCP 2.3) 

Video pattern generator (Pattern Generator). 

Status information and control of the downstream link (Link). 

EDID editor (EDID). 

HDCP status monitor and control (HDCP). 

DisplayPort Reference Source  

(MST ² 2 streams, HDCP 2.3) 

Video pattern generator 2 stream MST (Pattern Generator). 

Status information and control of the downstream link (Link). 

EDID editor (EDID). 

DPCD monitor (DPCD) 

HDCP status monitor and control (HDCP). 

DisplayPort Reference Source  

(SST, HDCP 2.3) 

Video pattern generator with custom patterns and SST  

(Pattern Generator). 

Status information and control of the downstream link (Link). 

EDID editor (EDID). 

DPCD monitor (DPCD) 

HDCP status monitor and control (HDCP). 

Executing HDCP 2.3 CTS Tests (Sink DUT Testing). 

 

A full description of the functions and the licensing can be found in Appendix B Licensing. 
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Change Device Configuration 
UCD-300 devices can feature four simultaneous interface Roles (please refer to  

UCD Console > Select Role below). Changing the role configuration is done by selecting the 

firmware packages loaded to the UCD-300 device. For selecting you need to open  

UCD Firmware Configuration utility in a special mode. The easiest way is to create a batch file 

with Notepad (e.g. config.bat) with the following content:  

u ucdconfig config  

In the special mode, you will be able to initiate the configuration dialogs. For that, select Change 

device configuration  check box. 

In the third dialog UCD Device Roles select the four roles that you prefer to be available in UCD 

Console. After selection, please click Next  to proceed to firmware update. 
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License Manager 

Licensing  

The features of UCD Console GUI are divided into groups based on the target use of the device. 

Most basic features can be used by default, and more advanced feature groups are enabled by 

dedicated licenses. When the licenses are present, the related part of the GUI will be shown, or 

the related control will be enabled. 

Unigraf licenses are provided as strings of characters, License Keys . Each License Key enables 

a dedicated function in one device. Each device has its dedicated Seed Number . Each License 

Key  is tied to one Seed Number . License Keys can be freely used in any number of PCs. 

License keys are managed with UCD License Manager . License manager can be found in the 

Tools  menu of UCD Console 2. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI  

When run, License Manager will list the licensing enabled Unigraf devices. In the list of Devices 

please Select  the device in question. The serial number and the seed number of your device are 

printed in a sticker attached to the bottom of the device.  

The Rescan¤ button will re-scan the system for installed hardware. 

Managing Licenses  

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number . Each unit has a unique 

Seed Number. Seed Number of the selected unit can be found in the top of the dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering Licenses. 
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Adding New License Keys  

To add a new license key for a device, please enter the characters from the license sticker to the 

field for new licenses. The License Manager will automatically move the caret across the edit 

boxes during typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click the Install . The license is authenticated and if it is valid, 

the license will appear in the list of installed licenses. If the key fails to authenticate, an error 

message is displayed. If this happens, please make sure that the key has been typed correctly 

and that the seed number on the license key sticker matches the seed number displayed in UCD 

License Manager. 

Please note that to avoid confusion, some letters will never appear in a license key because they 

resemble numbers: For example, capital 'G' and number '6' are very similar when printed with 

small font. When in doubt, use numbers. 

Also, please notice, that characters that cannot be part of valid license key are not accepted as 

input. When appropriate, an automatic conversion is applied while typing: For example, lower case 

letters are converted to upper case automatically. 

Managing Installed Licenses  

The Installed licenses list shows all installed licenses for the selected device. The list shows the 

name of the license and the actual license key characters. 

Remove Selected will uninstall selected licenses. To uninstall a license, click on the license and 

then click the Remove Selected button. 

Export will allow installed licenses for the currently selected device to be saved into an INI file for 

backup and distribution to other PCs. To export license(s), click on the license(s) and then click 

the Export button. Please notice that licenses from multiple devices can be exported into the same 

INI file. 

Import will install licenses from an INI file for the currently selected device. 
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UCD Console 

UCD Console Version 2 is the 2nd generation graphical user interface (GUI) for UCD family test 

equipment for desktop use. UCD Console provides the user access to all features of the unit. 

UCD Console also includes powerful debugging and analysis tools enabling the user to monitor 

the status of the display interfaces and assist in the problem detection.  

The various features of the UCD unit are divided into interface specific screens and tabs. Each 

tab contains data and controls for a specific feature.  

Note: This version of the User Manual describes features in UCD Console 2 based on the functionality 

in Microsoft Windows operating system.  

UCD Console 2 will be available also for macOS operating system to be used in iMac and 

MacBook computers and for Linux operating system. Detailed description of the macOS and 

Linux versions will be added later. 

Device Selection 
A shortcut of UCD Console can be found by default under Start Menu.  

Once UCD Console GUI is launched, the dialog provides a list of Unigraf UCD devices connected 

in the PC. Please select the target device by clicking on the appropriate button. If your device 

cannot be found in the list, please confirm the power and USB connection to the device and click 

the Rescan ¤ button. 

Analyzer and Generator Operation 
Most UCD devices can be used with UCD Console as Analyzer (a Sink device) and as Generator 

(a Source device). In default configuration UCD-300 family devices can operate in one role at a 

time.  

The operating role is selected when the device is opened in UCD Console. For changing a role, 

please close the device (File > Close Device), click Rescan ¤ if needed, and select the new role.  

This User Manual will explain all roles available for UCD-300 devices and the functionalities 

available for each role.  
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Options 
Options can be found in Tools > Options . 

Image File Format 

You can save the captured frames either in PPM, BMP, JPG or PNG bitmap file format. In PPM 

format the files are stored with the captured color depth, with other formats the color depth is 

truncated to 8 bits per color.  

Audio File Format 

Audio files are stored in WAV format 

Folders 

Please select the directories in the PC for saving the captured images and audio, the saved 

Presets and DSC test content and DSC Work directories. 

DSC 

DSC temp folder Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related configuration files and 

DSC conversion tools are stored. 

Automatically create 

missing content 

When selected, compliance test tool During execution of DSC 

Compliance Tests, the tool automatically creates the DSC 

compressed content used for testing the DUT. 

Keep auto-created By default, the DSC compressed content is deleted after use. If 

selected, the content is not deleted 

Warning Keeping the automatically created DSC compressed content will shorten the time needed for 

running the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large  

(appr. 400 GBytes). Please make sure that the content will be stored in a medium that has the 

required space available. 
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Misc. options 

Apply color conversions 

to saved images: 

When saving captured frames, the Color Mode selected in Video tab 

will be applied also to saved images. 

Bypass 4:2:x ²> 4:4:4 

conversions: 

4:2:2 and 4:2:0 images are previewed and stored as received, without 

pixel doubling. 

Disable firmware version 

check: 

UCD Console lets the user operate a non-matching Software / 

Firmware combination. NOT RECOMMENDED. 

DPCD Decoder flags 

Parameters for DPCD decoder in parsing AUX Channel transaction is DPCD Editor and Event Log. 

DETAILED_CAP_INFO_AVAILABLE: Information about DFP capability field in Sink DPCD 

register. 
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Detaching and Cloning Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and 

controlling separate features simultaneously. To detach a tab Right -click  on a tab and select 

Detach Window . To glue the tab back to the main window, click on the red Close button  in the 

top right-hand corner of the window or press <Alt> + F4  on the keyboard. 

Tabs can also be cloned (duplicated) in order to e.g., monitor various areas of DisplayPort DPCD 

or HDMI SCDC simultaneously without swapping addresses. To clone a tab Right -click  on a tab 

and select Clone Tab  or Clone and Detach  to the two actions simultaneously. 
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 ANALYZER OPERATION 
When used as an Analyzer, UCD-300 Series test equipment act as DisplayPort, HDMI or USB-C 

DisplayPort Alt Mode Sink or Receiver devices. 

User is selecting device role when opening the Device when launching UCD Console. Selecting 

DP Reference Sink, HDMI Reference Sink or DP Alt Mode Reference Sink, UCD Console operates 

as Analyzer. 

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, 

Interface Specific tabs present features and controls that are only available for a particular 

interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Standard Tabs  

Analyzer role features six standard tabs: 

¶ Video preview and saving (Video) 

¶ Audio monitoring and saving (Audio) 

¶ EDID editor (EDID) 

¶ HDCP status monitor and control (HDCP) 

¶ Source DUT Testing tab 

¶ Event Log 

Interface Specific Tabs  

Based on the connected UCD device, additional interface specific tabs will be available. 

UCD-301, UCD-323 and UCD-340: 

DP and USB-C DP Alt Mode Reference Sink 

¶ Status information and control of the upstream link (Link) 

¶ DPCD editor (DPCD) 

¶ SDP sent by the Source device (SDP) 

UCD-301 and UCD-323: HDMI Reference Sink 

¶ Status information and control of the upstream link (Link) 

¶ Received InfoFrame packets (InfoFrames). 

UCD-340: USB-C Reference Sink 

¶ USB-C Monitoring (USB-C) 

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing. 
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Standard Tabs 

Video Tab 
Video tab is the Preview window for the captured video frames. 

Disable / Enable Prev iew 

Click the button to start or stop capturing video frames. 

Video Status  

The details of the captured video are presented below the preview window. 

First row: Counter, frame size, frame rate, color mode, color depth, frame counter. 

Second row: Mvid, Nvid, Horiz Total, Vert Total, Horiz Active, Vert Active, Horiz Start,  

Vert Start, Hor Sync Width, Vert Sync Width. 

Third row: Live preview frame rate. 

 

Note: Please note that UCD test equipment are able to capture video at full frame rate.  

Live preview frame rate indicates the rate of updating captured video on UCD Console preview 

screen. Live preview frame rate is limited e.g by the USB communication between UCD test 

equipment and the PC. 
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Color Mode for preview  

 

No Conversion: The captured color components are mapped to R, G and B 

respectively. No color conversion will be done. 

Auto: The color mode is selected based on the information in the MSA.  

If there is no color information available, ¯No Conversion° is used. 

YCbCr (ITU-709) - > RGB: The captured data components are interpreted as Y, Cb, and Cr 

respectively. Color conversion to RGB is done based on ITU-709 

standard. 

SMPTE 170M - > RGB: The captured data components are interpreted as Y, U, and V 

respectively. Color conversion to RGB is done based on SMPTE 

170M standard. 

SMPTE ITU-601 - > RGB: The captured data components are interpreted as Y, U, and V 

respectively. Color conversion to RGB is done based on ITU-601 

standard. 

Note: Please note that the color mode selection applies to the preview window only. All internal 

functions use the raw image data as captured from the input channel. 

Frame recording  

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered mode 

can also be enabled in this dialog. 

Buffered When checked, all input frames are captured non-drop until the on-

board frame buffer will be full. 

When not checked, only one input frame is buffered at a time. 

Frames will be skipped if the transfer of the data to the PC is slower 

than the input data rate. 

Capacity of the buffer Capacity of the on board frame buffer with the selected video mode. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 
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Snap Frame 

 

When clicked, one frame of the incoming video is captured and shown in a new tab. Each click 

captures a new frame and opens a new tab. 

Color Information of the captured frame can be evaluated by placing the mouse cursor on top of 

the preview image.  

Info field in the lower right side of the bottom panel lists: 

¶ Location of the cross cursor on the bitmap stating from the upper left corner  

¶ The intensity of the color components of the pixel on the cursor location in HEX. Expressed 

as RGB and YCbCr. 

Zoom  

Zoom level of the captured frame can be altered by right clicking on top of the preview image and 

selecting between 

¶ Fit Window 

¶ Zoom 25% 

¶ Zoom 50% 

¶ Zoom 100% 

¶ Zoom 200% 

¶ Zoom 500% 

Save Frame 

The captured frame current tab can be saved to a bitmap file in the PC by right clicking  on top of 

the preview image and selecting Save as¤. The format and storage location can be selected in 

the opening dialog. The available bitmap formats are BMP, JPG, PNG, and PPM.  

Note: In PPM format the files are stored with the captured color depth, with other formats the color 

depth is truncated to 8 bits per color.  

The selections in Tools > Options menu define if the frame bitmap will be stored as captured from 

the display interface or if the color mode conversion selected for preview will be applied.  
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Buffered Capture (video, audio)  

Capture of video, audio and metadata in a file for later analysis. Video can be stored as RGB or 

RAW data.  

Data Chart indicates the approximate order of captured items with colored stripes (blue: video 

frames, green: events, red: audio data. 

Amount of frames The number of video frames captured. 

Events Please refer to chapter Event Log for details of the captured events 

Open storage folder Data save folder is defined in menu Tools > Options. Captured video, 

audio and data is saved in a subfolder of this folder. The name of the 

subfolder is ¯buffered_capture_yyyymmdd_hhmmss° (e.g., 

buffered_capture_20210301_130532). 

 

Note: Video Preview needs to be disabled to use Data Capture functionality. 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and 

recording. Up to eight channels will be shown based on the received audio stream. 

The audio signal format is shown in three ways 

¶ The ­oscilloscope® panel displays the waveforms of the received audio channels.  

¶ The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum 

display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum 

display can be selected between ­Linear® to 100 dB. 

The span of the oscilloscope preview window is defined with Playback buffer  found in Tools > 

Options dialog. The value is given in ksamples (1024 samples). The relation between the preview 

window span in milliseconds (msec) and the value given in Playback buffer depends on the 

sampling frequency. Please do not exceed the Main buffer set in the same dialog. Please refer to 

description of the Video Audio and Misc Options earlier in this document. 

Enable Preview / Disable Preview  

This button controls capturing the audio data. 

Select Monitored Stream  

When Multistreaming (MST) is enabled, the monitored stream can be selected from Current 

Stream  selection in the bottom of the dialog. 

Note: Please note that if the captured audio signal is constant, and audio signal frequency and audio 

sampling rate (e.g. 1000 Hz audio and 32 KHz sampling) match audio preview sampling rate, the 

­oscilloscope® panel will seem static. Signal capture can be verified by ensuring that Frame # 

below the panels is increasing. 

 












































































































































































































































